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1) Program Startup
As the program starts, you will be asked to enter your program password.  If you have not chosen one, 
the default password is “delphi”.  You can change the password once in the program by selecting Tools > 
Set Program Password from the top menu.

As the program begins to load, the splash screen shown below will appear.  During the startup process, the 
program will check for and download a new security token.  If you have changes in program access, the new 
security token will open new features of the program based upon your most recent level of NMT training.  
The program needs to download a new security token a minimum of once every 14 days.  If you have not, 
the program will give you a warning that you need to start the program while connected to the internet to 
do so.

In rare instances when you have a slower, or intermittent internet connection, the connection quality 
may cause this screen to hang during the startup procedure.  If you are temporarily on a low quality 
connection, you may want to disconnect from that network prior to opening Treeview.  This will allow 
the program to skip this initial check for a new token on the Treeview server, and open quickly.
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2) Program Window Layout
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Main Program Window Elements

1) Client Registry - The Client Registry is used for collecting, organizing, editing, and selecting client subject 
matter, transformation statements, etc. to use in the current session.

2) NMT Wizard - Directs the user through the ordered structure of the client session with pages where session 
subject matter, scope of awareness considerations, TOW, etc. may be introduced to the session, viewed, MRT 
measured, or changed.  

3) Session Scan Status - Shows status of scans run during the session, NMT Session Wizard Options tab allows 
user to show or hide the various NMT Wizard pages.

4) Client Registry Toolbar - Contains tools for working within the Client Registry.  The context sensitive R-click 
menu contains some of these tools.

5) Wizard Toolbar - Contains tools for working within the NMT Wizard.

6) Program Toolbar - Contains tools for working within the program.

7) Pathway Tabs - Contains tabs to select for any user authorized NMT Seminar pathway levels. Edit ML tab for 
editing in the Master Library.  NMT Wizard tab returns user to the Wizard.
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3) Start Session Wizard
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Start Session Wizard Elements

1) New Session - Begins a new session with the selected client.

2) Back - Allows user to add or edit selected client’s information

3) No Client Session - Opens the program in System Maintenance mode.  You may make general additions to 
the Client Registry, browse NMT Manuals, or print client reports and make MP3 files.

4) Client List - All clients in system are displayed alphabetically, and you may browse the list to select a 
previously added client.

5) Type Name, ID - As you begin typing a client name in this window, the list will jump to the client(s) 
beginning with the letters you type.  This is a quick way to get to a client name when you have a long list.

6) Check to Hide Clients - This check box hides the client name list for privacy.  You may select a client by 
typing the name in the Type Name box.

7) Search By - Allows you to search clients by last name or first name in Type Name box, and will sort the Client 
List by last name or first name when selected.

8) Add New Client - Use this button to add a new client to the Client List (shown in detail later).

9) Auto Select Test Client - Selects Test Client for program testing or practice sessions.

10) Show Guardian - Displays client guardian record information (shown in detail later).

11) Up/Down Arrows - Adjusts the text display size of the Client List.
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4) Adding New Client Records

1) Click on Add New Client button to add a new client.  

2) Fill in client information with minimum of client name.   Date of birth, gender, phone number 
and email address are very useful.

3) Click Save Client button to save the new client information.  You will get a confirmation of 
the added client. Then click OK, then Next button to begin session with this client.
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4.1) Adding Guardian/Child Relationship to Client Records
A new client may a child or an adult with a guardian. For such a client you may wish to link the parent/guardian 
record information. The parent/guardian will need to be added as a client first so that they appear and can 
be selected from the Guardian drop down list.  Such addition and linking of a guardian may be done at a later 
time.

Show Guardian button will bring up a window showing parent/guardian’s record 
information.  This information may also be accessed via the top menu item within the 
program, File > Table Maintenance > Clients.

Menu Item

6



4.2) Editing Existing Client Records

Method 1: At the start of the program, you may 
select client from the client list, then click the 
Back button to edit this client’s record.  When 
finished, click the Save Client button to save 
changes.

Method 2: At the start of the program, click the No Client Session button to put 
program in System maintenance mode.  Then from the top menu select File>Table 
Maintenance>Clients.  Select client in Clients Grid View tab, then click on the 
Clients Form View tab to edit record. When finished, click the check mark button to 
save changes.

Panel Buttons: 

Moves forward or back in client records

Add new record
Delete current record

Save or cancel changes to current record
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5) Treeview Client Registry
1

Client Registry Window Detail

1) Registry Tabs - Switch between Client Registry, View Image/Description, View Record Details, Filters, and 
Master Library.

2) Session Only Bins  - These orange label folders are used to hold session specific content.  Default folders 
are Session Matter: Current Session, and OHI Inclusions and Exclusions.  Others are available for use, if more 
are needed. Content from previous session is displayed in Session Only bins at the beginning of each session.  
Make sure to delete any subject matter no longer relevant to the session.

3) All Session Bins - These black label folders are for collecting subject matter and transformation goals.  These 
persist within the program, but can be hidden/deleted from view. Items may be moved to Session Only bins for 
use in a session, or copied/pasted to a Treeview pathway table or other location.  Material added to these bins 
may be made client specific or added for all clients, as shown in the next section.  

4) Registry Toolbar - Registry and other program functions are separated into icon groupings.  Full toolbars 
will be outlined further on.  Where used in examples, the icon will be shown along with the menu item in this 
manual.  Tools also can be found in the context sensitive R-click menu.

4) Registry Right-Click Menu - Right click within the Client Registry brings up context sensitive menu.  Many 
available operations for a particular item or folder can be found on this menu. 
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Adding Items: Double click on a 
folder in the registry to bring up the 
MultiNode Add window.  You can add 
new subject matter, one per line, then 
click OK to add material to folder.

You may also use the right click 
menu item, Add MultiNodes, or 
the keyboard shortcut Alt+P.  A 
single editable item can be added 
with the right click menu item 
Add Node > As Child.  Add Node 
menu item is also available from 
the top icon on the toolbar to the 
left of the Client Registry.

Newly added items are automatically check 
marked for moving to a Session-Only folder, 
or for copying to the program clipboard for 
pasting into a pathway table.

5.1) Adding/Organizing/Editing/Deleting Registry Material

Some items that you add within a session you may want 
available for all clients.  Checking this box makes the item 
viewable in all client profiles.  
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Organizing Registry Items: You 
may want to organize your own 
Client Registry material into 
folders of like items.  You might 
add related sub-items to a parent 
or topic node.

Double click on an item in 
the registry to bring up the 
MultiNode Add window, and add 
related sub-items.  

Adding items to another registry  node creates a folder/sub-item or parent/child relationship and changes the 
node’s icon to a folder image.  A single item may be made into a folder by using the menu item Change Node 
Status > Make Folder.  
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In practice, it is always best to plan 
ahead.  Organizing your Client Registry 
material as you are adding it will keep 
your registry clean and easier to use.

But if you have been using the 
program for a while, you may want 
to clean up your Client Registry by 
organizing existing material into 
folders, and deleting material no 
longer used.  We’ll look at doing that 
next.



Moving Items Around: Toggle Drag & Drop button on top toolbar to ON for moving items.  

Repositioning Items in Lists: A single item may be moved up or down in the registry by using the up and down 
arrows on your keyboard while holding down the Ctrl key.   Select the item to move by left clicking with your 
mouse, then holding down the Ctrl key, use the keyboard up and down arrows to change the position of the 
item in the list, as shown below.

Maybe you have some related items and 
want to add a folder to contain them.

Dragging and dropping items onto another 
node creates a folder/sub-item or parent/
child relationship and changes the item’s icon 
to a folder image. 

Use caution when using Drag & Drop, as it is easy to accidentally move items and lose Client Registry order.

D&D Items: Ctrl+click to select multiple items to move to the newly created folder.  Click and hold the left 
mouse button to drag the nodes over the folder.   As you drag over the node where you are moving the items 
to, it will highlight in light blue, and a Move icon will appear below the node.  Release left mouse key to drop 
the items into the folder.
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Deleting Items: In previous versions, users were not able to delete previously used Client Registry items.  In 
this version, you may delete any visible item within the registry.  Deleted items are now hidden from view and 
may be recovered at a later time.

Recovering Deleted Items: You might at some point want to recover some older registry material that you 
have deleted.  Or you may delete something unintentionally.  These items can be easily recovered.

You can use the menu item Show All 
Hidden Child Nodes/Folders shown below 
to reveal hidden nodes. Previously deleted 
items are then shown highlighted in black.

Select the item you wish to delete, 
and use the keyboard Delete key, 
or use the menu item Delete/Hide 
Selected Node(s).  You will be asked 
for confirmation to delete the item(s).
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UnHide each item you wish to recover by 
selecting the node, and using the menu 
item Change Node Status > Toggle Hide/
Show Selected Item/Folder.

When finished recovering, use the menu 
item Hide All Hidden Child Nodes/Folders 
to re-hide deleted material.

Recovering Deleted Client Registry Folders: You’ll notice that the new Client Registry is significantly cleaner 
than previous versions.  Folders were added previously that were not being widely used, or were not fully 
developed with content.  These older folders are hidden in this version, and you may recover them.

You can use the menu item Show All 
Hidden Top Folders to reveal hidden 
material. Previously deleted folders are 
then shown highlighted in black.

UnHide each folder you wish to recover 
by selecting the node, and using the menu 
item Change Node Status > Toggle Hide/
Show Selected Item/Folder as shown 
above.

When finished recovering, use the menu 
item Hide All Hidden Top Folders to re-hide 
deleted material.



Editing Items: Maybe you have a 
misspelled or incomplete registry 
entry, and want to make changes 
to it.  

Note:  You may only edit material 
you have added to the program 
yourself.  NMT Treeview owned 
items or statements may not be 
edited by program users.

Select an existing item in the 
registry by clicking it once with 
your left mouse button.  The node 
will change color to show it is 
selected, and the green indicator 
arrow will appear to the left.
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Then click the left mouse button 
again over the selected item.  This 
will cause the node to switch to edit 
mode, highlighting the text field in 
blue. 

Now you can place your cursor in 
the text field and change or add any 
text.  To place your cursor at the 
end of a long line of text, you can hit 
your right keyboard arrow when the 
item name is highlighted in blue.

Alternate Method: On the bottom of the 
Client Registry, you’ll see an additional 
panel with an edit field.  With a registry 
item selected, you can edit the item name 
in this lower panel.  This method may be 
preferred for longer item names such as 
Transformation Statements.  Click on the 
check mark on the top of the panel to 
save changes.  If you do not see the lower 
panel, maximize the Treeview window to 
full screen, and use the Toggle Registry 
Panel Height button shown on the toolbar.

Note on Editing Registry Items: You 
should only edit items in the case you 
have misspelled or left something 
incomplete.  You should not significantly 
edit a previously added item that you have 
used in another session.  You should add 
another item that is appropriate to the 
current session subject matter.



6) NMT Wizard
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NMT Wizard Window Detail

1) Wizard Page Index - Shows index and current position in Wizard.  Switch between Wizard pages by clicking a 
page title, or using the Next and Back buttons on the bottom of the window.

2) Display Window  - Displays contents of current Wizard page.  

3) Scan Status Window - Displays scans used during this session.  Also contains tabs for customization of 
Wizard pages.  

4) Wizard Toolbar - Tools for working in the Wizard.  

The NMT Wizard is an interactive tool used to help guide the user through an NMT session.  The wizard allows 
for a variety of initial scans, subject matter considerations, therapeutic optimization, and session conclusion.  
Over the development of the Treeview program and NMT Technique, new pages are added to accommodate 
the most current practices.  Pages may be hidden or shown to customize the NMT Wizard to your own 
preferences.
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Toolbar Buttons

a) History - Shows list of previous sessions with client.  

b) Notes  - Opens Session Notes window begun at start of session.  

c) Reset Signal Output - Resets signal output.  If wizard scan or query is stuck in readout, use this button to 
reset and continue with next statement.  

d) Up/Down Arrrows - Used to increase/decrease wizard display text size.

e) Reset Display - Resets wizard display text to default size.

f) Help - Pops up help guide.

g) Focused Scan - Outputs scan in context of current wizard page.  For Subject Matter and OHI, the scans are 
specific to Session or OHI subject matter.  On other pages, this button outputs a simple IFs scan.

h) Pathway Launcher Setup - Pops up window that allows user to choose which pathways show up in pathway 
launcher.

a b c d e f g h

NMT Wizard Toolbar

Wizard Page Detail - Welcome Page

Initial Wizard page.  Check marking Autoset Wizard responses to default values will initialize all wizard page 
metrics to presumed optimal values.  Values can be changed if indicated.

16



Wizard Page Detail - OTC Optimization

You may set Rate (speed) of text-to-speech output with the slider bar on top.  The button on the bottom of the 
page outputs the statement, “Is this the most effective setting for OTC communication?”   MRT this statement 
to find the optimal output speed.  

Wizard Page Detail - Session Subject Matter

The Session Subject Matter page allows the user to output a scan with specific reference to a registry session-
only bin.  So we start with a brief look at using the Subject Matter: Current Session bin.  

To move items to the Subject Matter: Current 
Session bin.  Check mark items you want to move, 
then use the menu item Move checked Contents 
of Class to... > Subject Matter: Current Session.  
You may want to do this at the beginning of a 
session, so that it is ready when you get to the 
Subject Matter scan in the Wizard.
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Check marked items are transferred to the 
Subject Matter: Current Session bin, as shown 
here. 

On the Session Subject Matter Wizard page, click 
the Retrieve Subject Matter from Client Registry 
button, then press the Start Scan button on the 
bottom of the page to output the session matter 
specific scan. 

Items transferred to session only folders persist 
from session to session for each client.  When 
you begin a new session, delete any items in the 
Subject Matter: Current Session bin that are no 
longer relevant to the current session.

You can select items and use the Delete key, or 
to clear everything, select the bin and use the 
menu item Clear this Session-Only Bin of all 
items.

* note the distinction between checked and selected 
items/nodes in the menu items.  Checked refers to items 
that have check marks next to them.  Selected is when 
the item is clicked with the mouse, and changes color to 
indicate it is selected.  Multiple items may be selected 
by holding down the Ctrl key when selecting items, or a 
group of items using the Shift key.
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Wizard Page Detail - Scope of Awareness Scan

The Scope of Awareness page allows the user to output and record TSB for a number of general considerations.   
You can click the [+] sign next to a category for more specific items within that category.

Wizard Page Detail - CPQQ

The CPQQ (Clinical Pathway Qualifying Query) page allows the user to output and record metrics for CPQQ 
considerations.   Click on each query statement to read out and pop up a log scale for recording value.

Click in the Log TSB column to the right of an item to bring up a scale for recording value. You can use 
the red slider needle to select a value, or type a value into the box in the lower right-hand corner.
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Wizard Page Detail - OHI Scan

The OHI page allows the user to output a scan with specific reference to the registry OHI session-only bins.  
We’ll look at using the OHI Erroneous Inclusions: Session Only and OHI Erroneous Exclusions: Session Only 
bins.  The Client Registry Optimal Health Image all-session folders contain standard lists of OHI inclusions and 
exclusions that may be used in the Wizard OHI scan. You can add your own by double clicking on one of the 
OHI folders to bring up the MultiNode add window.

Check mark indicated OHI Inclusions in the OHI 
Inclusions standard list folders and then use the 
menu item, Move checked Contents of Class to... 
> OHI Erroneous Inclusions: Session Only Bin.  
This will transfer inclusions to the session only 
bin.

Similarly, check mark indicated OHI Exclusions in 
the OHI Exclusions standard list folders and then 
use the menu item, Move checked Contents of 
Class to... > OHI Erroneous Exclusions: Session 
Only Bin.  This will transfer exclusions to the 
session only bin.
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You may assemble the OHI subject matter either at the beginning of the session, or when you come to the OHI 
Scan page.  After OHI material is transferred to the session only bins you can transfer them to the Wizard OHI 
Scan page using the Retrieve OHI Erroneous Inclusions and Exclusions from Client Registry button.  This will 
transfer inclusions and exclusions to the wizard display window.

Now you can output the OHI subject matter specific scan by 
using the Wizard Toolbar Focused Scan button.  
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OHI Contracts Builder

Within the OHI Erroneous Inclusions: Session Only bin is a special use folder for specifying OHI Contracts.  
Double clicking this folder will bring up the Contracts Builder dialogue shown below.  Each contract consists 
of up to three parts: With, In regard to, and About.  Clicking each column will bring up a drop down list that 
will allow you to select each part.  Click the [+] button on the top toolbar to add additional contracts.  When 
finished click OK to add the completed contracts to the OHI Inclusions folder.
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Now you can transfer the specified 
contracts to the OHI Erroneous 
Inclusions: Session Only Bin along with 
any items checked in the Standard List 
for All Patients.  Use the menu item, 
Move checked Contents of Class to... 
> OHI Erroneous Inclusions: Session 
Only Bin.  This will transfer inclusions 
to the session only bin.   



Wizard Page Detail - Therapeutic Optimization Worksheet

The TOW page provides a query to apply the full TOW Worksheet.  Confirming with a check mark launches the 
TOW table in the Universal Care pathway tree.  TOW assumes the place of older PEP, PPP, and SSP.

The TOW Table duplicates the NMT Universal Care TOW Worksheet within Treeview.  Use the drop down list 
to select the intended target, and click in the TSB and/or IFs & IFs-h column to the right of each statement to 
record metrics.  You may also use a simple indication by check mark in the indicated column, and then quantify 
TSB in aggregate for all indicated statements at the bottom of the table.*

*tables will be discussed in full detail further on in this manual.
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NMT Wizard - Stacking Scans

In NMT, the concept of stacking scans means that we may run a number of scans in a row, and do a single 
correction at the conclusion to correct any faults brought to awareness by the series of scans.  In Treeview the 
TOW Worksheet is the last Wizard page prior to coming to the Pathway Launcher, and up to this point we may 
have run one or more scans in regard to our initial considerations for this session.  So it is at this point within 
the program that we will “Stack Scans“, by outputting a correction statement.

When you use the Next button to progress from the TOW Check to the 
NMT Pathway Launcher in the Wizard, the Stack Scans procedure will 
automatically launch.  You will see a quick pop up confirmation, telling 
you that it is time to stack scans and make a correction.  Then a vernier 
scale will pop up, allowing you to quantify IFs for all scans up to this 
point.  After quantifying IFs and closing the scale, a Universal Correction 
Statement is output and a Set or Make Correction icon (below) appears 
on your screen to remind you to do an anchoring procedure at this point 
(usually with breathing cycles and tapping or Arthrostim application).

If Stack Scans procedure does not start 
automatically when going from TOW to Pathway 
Launcher, you may manually start it by clicking 
in the IFs column to the right of a scan in the 
Session Scan Status window.
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Wizard Page Detail - NMT Pathway Launcher

The NMT Pathway Launcher serves the purpose of the NMT Pathway Pyramid within Treeview.  You see that 
the pathways are arranged by groupings as in the Pathway Pyramid.

Pathway Launcher Details

a) Pathway Groupings - Pathways are split into Pathway Pyramid groupings.  By default, all pathways from users previous 
NMT training are displayed.  You may limit the pathways displayed for ease of use.

b) Pathway Priority Queries  - Outputs the query statements “Is there now a pathway priority in regard to BLOCKED 
HEALING and RESPONSE TO CARE?“, and “Is there now a pathway priority in regard to SESSION SUBJECT MATTER?“.  

c) Indicated Column - Use this column to MRT for and note any pathway that is indicated as useful, but may or may not 
actually be used. 

d) Priority Column - Use this column should you wish to MRT for and note a simple numerical priority for pathway (1, 2, 
3, ...n).

e) Additional Evaluation Columns - Use these columns if you wish to test for and record details about the TSB: TSB 
Relative to (time), Relative TSB (increase/decrease), TSB % (numerical), Log TSB (numerical).

f) Sort Pathway Launcher - View NMT Pathways by group or alphabetical listing.

g) Pathway Launcher Setup - Pops up window that allows user to choose which pathways show up in pathway launcher.  
You may wish to limit pathways that appear in the launcher to those you typically use, e.g., Universal Care Levels A, B, 
and C.  You can still navigate to any NMT pathway not kept in the pathway launcher by selecting the Pathway Tab the 
desired pathway is in.

h) Go! Column - After determining pathway priority, click the grey square button in the Go! column to open the selected 
pathway.  Alternatively, click the Pathway Tab in which a pathway is located and just begin using that pathway.

i) PW Column - Hovering over this column pops up group/pathway description (for Universal Care Pathways only).
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Wizard Page Detail - Session Execution Check

The Session Execution Check may be used to reinforce the corrective effect of a session.  This option adds 
another layer of correction reinforcement, if desired, to the Push Scan at the end of each pathway.

Wizard Page Detail - Session Reinforcement Check

Use MRT or executive choice to determine the best method of session reinforcement - ACS, MP3, or both.  
If you wish to output a statement to scalar for MRT, just click on the statement.  Check mark the indicated 
reinforcement options. If ONLY MP3 is chosen, Wizard skips to Correction Amplification 3 wizard page.
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Wizard Page Detail - Correction Amplification 1

Use this reinforcement option if you wish to specify an optimal duration, frequency, and power multiple for 
reapplying the therapeutic intention of the session. Use drop down lists to record results.

Wizard Page Detail - Correction Amplification 2

Use this reinforcement option if you wish to specify an optimal duration and frequency for MP3 scalar play 
back.
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Wizard Page Detail - Correction Amplification 3

This applies the Universal Correction Statement to the session reinforcement choices you have just selected.  
Check the Confirm and Apply box to output the UCS.

Wizard Customization Options

You can customize the NMT Wizard to show only the pathways and wizard pages you want to use.  For a clean 
look and easy pathway selection you may wish to show only the pathways you usually use.  For instance, show 
only the NMT-UC pathways.  To use other pathways select the Pathway Training Level tab that pathway is in 
and just start running that pathway.

Pathway Launcher

You might want to hide 
previous level pathways that 
are now replaced by Universal 
Care pathways.

Use the Pathlauncher Setup 
button on the Wizard Toolbar 
to  bring up the setup window.  
Uncheck the pathways you 
want to hide from view.  
You will need to restart the 
program in order for the 
changes to take effect.
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Wizard Pages

If there are Wizard pages that you find you do not use, you may hide those pages to streamline it to your own 
use.  For instance, the 2 CPQQ pages, since that intention is included in current pathway wording. Click on 
the NMT Session Wizard Options and NMT Wizard Settings tabs in the Scan Status window below the Wizard. 
Uncheck the Include? column for the pages you no longer want to display. You will need to restart the program 
for the changes to appear.

Depending on your screen resolution, you may not be able to fully see the Scan gallery window.  Drag the solid 
grey “splitter“ bars to the left and bottom of the Wizard panel to expand the bottom panel enough that you 
can click on the tabs and see the Wizard page list displayed as shown. 
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7) NMT Pathways
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Pathway Custom View (CV) Trees

1) Pathway Tree Tabs - Pathways are split into tab groupings split by training level.  All pathway tabs from 
user’s previous NMT training are displayed.  Click the GO! button for the selected pathway in the Pathway 
Launcher and TV takes you to the beginning of that pathway. You may access any pathway directly by clicking 
the training level tab it is in and begin working the pathway.

2) Pathway Display  - Displays the Custom View pathway statements and table trees. Click on any query or 
correction statement to output it to scalar. Double click any pathway table icon to open it.

a) Pathway Table  - Treeview uses tables as worksheets for user data entry. Tables are represented in the 
pathway display as grid icons. Double clicking on the table name to open the table.

b) Pathway Statement - NMT Pathway statements will display as a folder icon, and in some cases may have 
sub-statements.  In that case, the parent statement will display with a [+] sign next to it.  Click the [+] to open 
the tree of sub-statements.

3) View Image/Description Tab - When you click on a pathway in the Pathway Launcher, the program should 
automatically switch to this image/description tab.  You may click back and forth, accessing Client Registry or 
other tabs and then back to View Image/Description to continue running the pathway.

4) Image/Description Display - Displays the contents of the statement selected in the CV Tree pathway 
window.  There may be descriptive text, output statements, or a combination of both.

   To return to the registry, click on the Client Registry tab.
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NMT Pathway Structure

You will notice that within Treeview, each NMT Pathway has a similar structure, consisting of: 1) Definition of 
transformation states and evaluation of metrics in a table followed by a correction statement, 2) A forward 
looking scanning and correction statement followed by a group of pathway specific statements and tables, 3) A 
final Universal Correction Statement, 4) Pathway is completed with the NMT Push procedure. 

The Simple Table

NMT pathways in treeview all contain one or more tables.  The first of these is the Subject Matter and 
Objectives table, where the Transformed FROM and TO states are defined and quantified.  Tables will be 
covered in greater detail in the next section, but we will look at how to add simple statements to tables in this 
example.
Adding Items: From the Right-click menu in the table, choose Add Row to Grid.  You will get a pop up that 
asks you for the number of rows to add.  After selecting the number of blank rows to add, you will be given a 
confirmation, and then the option to add as child (sub level) or to append, adding the row to the end of the 
rows of the same level of tree organization.
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The newly added row is 
highlighted in yellow, and 
now you can double click 
on the new node to edit it. 
We’ll look at other ways of 
adding material to tables in 
the section on tables.

To quantify metrics, you can 
click on any of the columns 
to the right to record values.

NMT Pathway Statements

Pathway statements are made of complex data objects called “nodes” in Treeview.  These have a name, as 
seen in the right-hand panel below, and a description as seen in the left panel that can contain plain text as 
instruction or discussion or highlighted text, which is output to the scalar antenna.  A node can also have an 
associated image or audio component.  Here you see the highlighted text in the description panel is being 
output in the scan read along window.  As you progress through a pathway, you will follow the statement tree 
downward, clicking on statements to output and completing tables as indicated.
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In NMT Universal Care, we use 
unique types of MRT for different 
query or correction statement 
elements.  The <MRT-S-a>, and 
<MRT-D-c> tags should be familiar 
to you from your Level A manual.

In the description window you 
will see the different statement 
elements separated by their 
respective <MRT> tags.  

The [CORRECTION] tag at the 
bottom of this window tells the 
program to output the Set or Make 
Correction icon shown on the 
previous page.

The NMT Push Scan

In NMT Universal Care, we have the option of completing a pathway with the NMT Push, whereby we re-
evaluate TSB of the Transformed FROM System State and reapply the therapeutic intention of the pathway to 
optimize results.  In Treeview, there is an interactive scan dialogue to reproduce this procedure.

1) Double click on The Push Scan Table to start the NMT Push dialogue, beginning with a query for the TSB 
metric for the Transform From State.  Record value on pop-up log scale to continue to the next step.
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2) Next a query to the benefit of reapplying the therapeutic intention of this correction 1000 times in the next 
10 seconds.

Query Response NO: No further correction is necessary.  
The Push Scan dialogue closes.

Query Response YES: Universal Correction Statement is 
output, and The Push Scan dialogue remains open, so 
that we may repeat the procedure.

After each correction, a new row is added to 
this correction loop table.  Click on the TSB 
Log column in the new row to begin the Push 
loop again.  You may repeat this until the TSB is 
sufficiently low, and you get a NO response to 
query for reapplication of therapeutic intention.
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8) Treeview Pathway Tables

1

2

3

Tables in the Treeview program are used to record more complex data that we need to duplicate NMT Pathway 
Worksheets.

1) Table Rows - Tables may have one or more rows.  Table rows can be simple placeholders, as in this example 
where we add specific subject matter for the session or pathway.  Other examples will have complex detail, 
such as anatomical structure tables.

2) Table Columns  - Used to record metrics or other data associated with table rows.  We have seen the pop-
up log scale used to record TSB.  There are other ways of recording different types of data that we will show 
examples of as we go forward.

3) Table Toolbar  - some common tools.

a b c ed

a) Add/Delete Ad-hoc Row - Delete selected row, or Add new row.  We saw how to add a row in the example 
of a simple table in the previous section.

b) Clone Table Data - Recover user added rows and metrics from any selected previous session with current 
client.  Text may be edited and metrics replaced with new values.

Click the Clone Table Data icon on the toolbar.  
Table uses from previous sessions are listed.  
Select the session data that you want to 
restore, and click OK. 
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c) Add All Sessions AdHoc Rows - Recover user added rows from all previous sessions.

d) Search in Table - Find items in table.  Useful for finding specific item in long lists.

e) Up/Down Arrows - Increase/decreases text size.

Table Data Menu 
The Table Data menu on the top of the table duplicates toolbar tools, but has a few more useful tools.

Clone data from last time table used 
Recovers all user added rows and column values from most recent session.

Clone Only AdHoc Rows from last time table used 
Recovers only user added rows from most recent session.

Clone Table data from previous session 
Recovers all user added rows and column values from session chosen from history list.

Display Table from previous session 
Displays table from any previous session chosen from history list. Use to compare metrics from a previous 
session or to find and/or copy and use in this current session material that was used in an earlier session, but 
not in the last use of the table.
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Clear all table cells 
Clears only values from columns of all table rows. 

Clear all AdHoc rows 
Removes all user added rows and column values from table.

Add All Sessions AdHoc Rows 
Recover user added rows from all previous sessions.

Clear Clipboard 
Deletes saved items from memory, in case you want to re-copy material to clipboard for pasting into table.

Show only “Indicated” rows 
Shows only rows with check mark in the indicated column

Table Right-click Menu 
Right click your mouse over the main table display area.  The right click menu has a few more useful tools.

Add Row to Grid 
Add rows to table.

Paste Client Registry Node(s) (Ctrl+V)
Paste items copied from Client Registry.

Copy Selected Rows to CV Table Clipboard 
Copy table rows to clipboard for pasting into another table.

Clear CV Table Clipboard Contents 
Deletes saved items from memory, in case you want to re-copy material to clipboard for pasting into table.

Edit First Column 
Opens editing of the first column (text) of any user added row.  You may also just double click the first column 
of a table row to open the row editor.

Expand/Collapse Node to Show/Hide Children 
Shows or hides child nodes in table.

Delete Selected User-added Rows 
Delete selected row(s).  To delete multiple rows: Hold the Ctrl key and click each row to be selected, then 
select delete from the R-click menu or use the delete key.  Continuous range of rows: Select the first row and 
the hold the Shift key while selecting the last row in the range to select that whole range, then select delete 
from the R-click menu or use the delete key.
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8.1) Copying Registry Material Into Tables
Copy Selected Items 
You might want to copy only a couple of rows from the registry into a table.  An easy way to do this is to select 
items and copy to the clipboard for pasting into the tree.

You can select multiple items by holding
down the Ctrl key while selecting each 
item.  Or, to select a range of rows select 
the first row of the range and hold the 
SHIFT key while selecting the last row to 
select that whole range.

Then use the menu item shown, or the
keyboard shortcut Ctrl+C to copy the
items.

Go to your table, select a row to paste to, 
and use the tables right click menu item 
or the keyboard command Ctrl+V to paste 
items into the table.

You will be asked 
whether to add the 
rows as child or to 
append.

“Add As Child” adds 
the items as sub rows 
to selected table row.  
“Append” adds the 
items as siblings on the 
same tree level.
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Copy Checked Items in Folder - Simple Example 
This method allows you to check mark multiple items in a registry folder for pasting into a table.

Indicate multiple items in a folder by 
placing a check mark in the box to the left 
of each item.  Then use the menu item 
shown, or the keyboard shortcut Ctrl+Z to 
copy the items.

Go to your table, select a row to paste to, 
and use the tables right click menu item 
or the keyboard command Ctrl+V to paste 
items into the table.

You will be asked 
whether to add the 
rows as Child or 
Append.

As Child adds the items 
as sub rows to selected 
table row.  Append 
adds the items as 
siblings on the same 
tree level.

These are the two simplest ways to copy items from the registry for use in tables.  Many times you will use 
more complex examples that we will look at now.
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Copy Checked Items in Folder - Complex Examples 
There are some special use tables and registry folders that allow us to do more complex copy operation in an 
easy and quick manner. These more complex examples associate particular parts of the Client Registry with
specific tables. A primary example of this includes Transformation Statements, the Subject Matter and 
Objectives tables, EDP Statements, TSKP Statements, and OHI Statements, and their associated tables.

8.2) Special Use Tables

TFS/TTS Registry Statements Copy (Ctrl+Z) to Pathway Tables
The transformation states folders are an example of special registry folders where we can copy both the TFS 
and the TTS statements in a single copy operation, and then a single paste into a table.

The active folders for 
TFS/TTS statements are 
the Session Pathways 
Transform FROM/TO 
Statements folders 
shown here.  After 
adding or selecting both 
TFS/TTS statements, 
you can do one Ctrl+Z 
copy operations to copy 
all statements to the 
clipboard.

A good demonstration is to add one statement each to the Session Pathways Transform FROM/TO Statements 
folders, and then Folder Copy (Ctrl+Z) once to copy both statements, open a table and paste in the contents of 
the clipboard.

Double click the Session Pathways 
Transform FROM Statements 
folder to bring up the MultiNode 
add window, and type in your TFS 
statement(s).

You may also use the right click 
menu item shown, or keyboard 
shortcut Alt+P to add statements.
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Add your statement(s) 
to the Session 
Pathways Transform TO 
Statements folder in the 
same way as above.

Now you can do one folder copy (Ctrl+Z) to copy all 
check marked statements in both folders.

When you open a Pathway Subject Matter and 
Objectives table in any pathway, you can do one 
paste (Ctrl+V) that will separate the TFS and TTS into 
their respective placeholder folders in the table.
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TSKNP  and EDP Registry Statements Copy (Ctrl+Z) to Pathway Tables
TSKNP and EDP registry folders work identically in Treeview.  We will only look at the TSKNP, but you can apply 
the same method with EDP registry folders.

You’ll see the TSKNP and EDP registry folders 
have sub folders arranged by general issue, 
and these have sub folders Negative Issues 
and Positive Issues.  Each of these folders 
contain a collection of statements for that 
issue.

MRT to determine the applicable general 
issue category, then query statements in the 
Negative Issues and Positive Issues folders.

Check mark those that are indicated in the 
Negative Issues folder, then minimize that 
folder by clicking on the [-] sign to collapse the 
folder and move on to Positive Issues.
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After check marking all indicated 
statements in the Positive Issues folder, 
you can do a single Ctrl+Z to copy all 
check marked positive and negative 
issues statements.

You may also use the menu item shown 
here to copy all statements.

When you open the TSKNP Table and 
paste (Ctrl+V), the positive and negative 
issues will be separated into their 
respective placeholder nodes in the 
table.

You also may use the right click menu 
item to paste.

43



OHI Registry Statements Copy (Ctrl+Z) to Pathway Tables
We saw previously how to transfer OHI registry statements into the OHI session only registry bins in order to 
use in the OHI specific Wizard scan.  You may want to run the entire OHIP pathway in Treeview, and in that 
case, you will copy the OHI statements to the clipboard to paste into the pathway table.

Check mark 
indicated statements 
in both OHI 
Erroneous Inclusions 
and Exclusions 
folders.  Then you 
can do one folder 
copy (Ctrl+Z) to copy 
all statements.

When you paste 
(Ctrl+V) into the 
table, the program 
will split out the 
inclusions and 
exclusions into their 
respective table 
placeholder nodes.
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8.3) NMT Transformation Templates

General Issue Category Transformation Templates
With this group of templates, we have corollary statements in the TFS and TTS folders for each issue.  In use, 
we select the TFS statements, and then check mark the corresponding TTS statements for that particular issue.

NMT Transformation Templates were introduced in the Symposium 2013 training.  There are two groups of 
templates, arranged by general category, and condition specific.  The two are handled a little differently in 
Treeview, so we will look at both here.

We’ll usually want to edit some of the template 
statements to add specific reference to the client’s 
complaints or goals for this session.  We can’t edit 
NMT owned material, so we copy statements to the 
intermediate folders Practitioner/Client Transform 
FROM and TO Statements, and we can edit the copied 
statements.

First we check mark the indicated TFS statements in the 
General issue category folder, and then we go to the 
TTS General issue category folder, and check mark the 
corresponding numbered statements. 

Once we have check marked all indicated statements 
in both TFS and TTS folders, we can copy them to 
the Practitioner/Client folders using the keyboard 
command Ctrl+N, or use the menu item shown here.
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Once in the Practitioner/Client Transform 
FROM and TO Statements folder we can 
edit the copied statements to add specific 
reference.

When finished editing, we can again do a 
single folder copy (Ctrl+Z) to copy the edited 
templates from both Transform From and 
Transform To folders to the clipboard.

When pasted to a Subject Matter and 
Objectives table in any pathway, the 
statements will be separated out into their 
respective TFS and TTS table nodes. 

Subject matter that has been collected in 
the Practitioner/Client TFS and TTS folders 
remains available from one session to 
another, may be modified further if indicated, 
and can be deleted/hidden when no longer 
needed to keep this client registry area tidy.
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Condition Specific Transformation Templates
With these templates, we have groupings of TFS/TTS statements according to condition, and we use all 
statements in the TFS and TTS folders for that particular condition.

We may want to edit some of the template 
statements to add specific reference to the client’s 
complaints or goals for this session.  We can’t edit 
NMT owned material, so we copy statements to the 
intermediate folders Practitioner/Client Transform 
FROM and TO Statements, and we can edit the 
copied statements.

First we open the Condition Specific Templates: TFS 
folder and select the condition we are addressing.  
Select the main condition folder (Anchored Trauma 
in this example), and then right click and select 
Check all children/grandchildren of Selected node.  
This will check mark all statements in this TFS folder 
as well as all the statements in the corresponding 
TTS folder.

With all the Anchored Trauma template 
statements check marked we can copy them to 
the Practitioner/Client folders using the keyboard 
command Ctrl+N, or use the menu item shown 
here.
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Once in the Practitioner/Client Transform 
FROM and TO Statements folder we can 
edit the copied statements to add specific 
reference.

When finished editing, we can again do 
one folder copy (Ctrl+Z) to copy the edited 
templates to the clipboard.

When pasted to a Subject Matter and 
Objectives table in any pathway, the 
statements will be separated out into their 
respective TFS and TTS table nodes. 
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8.4) Practitioner/Client Folders for EDP and TSKNP
You’ll see that the registry Time Space & 
Knowledge Statements and Energetic Dynamics 
Statements folders have Practitioner/Client 
folders, as in the Transformation States folders, 
each with Positive/Negative Issues sub folders.   

We may want to collect more relevant issues for 
a particular client so they can be easily reused.  
We may also want to edit some of these NMT 
owned statements, so we copy them to the 
intermediate Practitioner/Client folders and we 
can edit the copied statements. 

In Both EDP and TSKNP registry folders we also 
have sub folders arranged according to general 
issue categories, and each of these have a 
Negative Issues and Positive Issues folder. 

We check mark both Negative and Positive 
Issues statements that we want in any 
indicated categories and then copy them to the 
Practitioner/Client folder.  We will look at the 
example of the EDP only here, but the procedure 
is identical for the TSKNP.

Once we have check marked all indicated EDP 
statements in both Negative Issues and Positive 
Issues folders, we can copy them to the Practitioner/
Client folders using the keyboard command Ctrl+N, 
or use the menu item shown here.
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Once in the Practitioner/Client EDP 
Statements folder we can edit the copied 
statements.

When finished editing, we can do one 
folder copy (Ctrl+Z) to copy the edited 
templates to the clipboard.

When pasted to the EDP table in the EDP  
pathway, the statements will be separated 
out into their respective Negative Issues 
and Positive Issues table nodes. 

Statements that have been collected in 
the Practitioner/Client EDP folder remain 
available from one session to another, may 
be modified further if indicated, and can 
be deleted/hidden when no longer needed 
to keep this client registry area tidy.

The TSKNP Table varies slightly from the EDP, as we are not looking at yes/no energetics in the TSKNP.  But the 
procedure for copying to the table is identical to this example of the EDP.



8.4) Quantification in Tables

Quantification and Other Data in Tables

As we progress through a session, there will be a number of different things that we need to record, and 
Treeview provides a variety of tools for adding information to the tables.  We have already seen a few 
examples.  There is the pop-up scale for recording TSB or other numerical data.  The scale may be set 
differently for a particular context, but you can always manually enter the value in the pop-up scale.  This 
example shows two scale variations.  This also shows an example of a text field to type in, and multiple check 
box to record affirmative indications.
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Why Quantify?

NMT queries are qualitative, and always ask the question “what”.  Quantification produces a much more 
powerful level of observation by adding “how much” to the picture.  The key element of using quantification 
is to present the “how much” query to the mind-body.  How detailed your quantification query becomes is 
less important than the fact that you ask “how much”.  So, keep in mind that the level of quantification you 
introduce should be in agreement with your comfort in doing MRT of quantification.  Some people find taking 
many metrics during an NMT session is quick and easy.  Others find that it is a burden, mentally fatiguing, and 
slows down their NMT sessions.  So, find a balance between how much quantification detail you choose to 
do and staying comfortable and relaxed while you do your sessions.  You can produce valuable quantification 
observations and still keep in your comfort zone by using strategies like finding a metric for an aggregate group 
of items or questions for which you want to make a quantification.  For instance, for ISOP instead of taking a 
separate metric for sensitivity, specificity, cross-reactivity, tolerance, and power you might do one aggregate 
TSB metric to cover all of those.  For a table of queries such as with TSKNP you might just take one aggregate 
metric for all positive statements and one aggregate metric for all negative statements.  The important thing is 
that you directed the mind-body to consider “how much”.
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The example below of the TOW table shows a drop down list.  Use your mouse to make selection from the list.  
You may see examples not shown, but it should be clear from the context if you click on a table column cell.  If 
it isn’t clear, contact Treeview support, or review the training material or worksheet for the particular pathway.

Table Cell Builder in the ASP Table
In the ASP, we look at indicated catabolic and anabolic states in regard to a particular challenge or series of 
challenges presented during the pathway.  We may repeat this over a series of steps.

The cell builder tool in Treeview allows us to choose from a possible list of Catabolic/Anabolic States and 
Localized to regions.  Clicking on the cell in one of these columns will bring up the cell builder.

Check mark all indications in the cell builder and 
click the Close button to add those abbreviated 
states to the table cell.

Within the same session, the cell builder will recall 
the last use, so when you open it on another run, 
the same states will be check marked.  Use the 
Reset button to clear the checked states.

A right-click menu within the cell builder allows 
a row to be edited, added or deleted.  Hovering 
your mouse over the  “Hint” column will pop up a 
definition of the emotion.



9) Closing Session/Sending MP3 and GEF Files

Finishing the NMT Session - When you have completed the session to your satisfaction and finished the final 
correction amplification in the Wizard, use the Finish button or the Close Session button on the top toolbar to 
bring up the Close Session Notes window.

Closing Session Notes Window
Allows user to make final session notes, produce MP3 & GEF, and email files.

Set Session Status  - Set session status.  
	

Cancel Close  - Returns to current session to continue working.

Finish Session  - Closes session with indicated session status.  Program will ask if you want to continue with the 
program or close, then give you options to auto-backup and open Batch Email window (shown later).

Complete - session is finished.  
Incomplete - session was interrupted and will be continued at a later time.
Not a Session - In case you want to enter a session to look at subject matter or table 
data for a particular client, but do not want it to show as a session in client history.
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Charges  -  You can set charges and session time for inclusion in GEF report.  Clicking the Charges button on the 
closing session will bring up the window below.

a) Rate Window - Set hourly rate.

b) Set Session Time  - Manually set total session time.  
	
c) Minimum Times/Charges  - Set minimum for session time, rounding, surcharge.

d) Calculate Charges  - Calculates charge for session based on time, hourly rate, and minimums.

e) Print Options  - Checked includes Charges in GEF report.

a
b

d

e

c
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GEF - The Global Evaluation Form (GEF) within Treeview is a document that allows us to present session details 
to client and/or keep for our records.  There are tabs on the GEF form to set up options for what to include in 
the form.

Save PDF - Saves GEF form as Adobe PDF.

Print - Sends GEF to default printer.  If this does 
not print correctly, you may try saving as PDF, then 
printing the PDF.

Preview - Opens PDF preview window to view GEF.

Cancel - Returns to Close Session window.

Add/Remove All Tables - Checks or unchecks all 
tables in right hand display tree.

Tables in Report - Options for selecting which 
tables to include.

Display Tree - Shows tables used in session.  You 
can individually check or un check tables to include 
in report.

Section in Report Tab - Select which sections to 
include.  You probably will not make changes in this 
tab.  Limiting Tables displayed by using the Tables 
in Report tab above should be sufficient.
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MP3 - NMT Treeview can make an MP3 of the session.  The MP3 is constructed based on the scans, pathways 
and tables you have completed.  Treeview MP3s are audio files of the session content converted to speech, 
and is intended to be played through an NMT Treeview Scalar Antenna or “Zinger” antenna only.   Depending 
on the number of pathways/tables completed, the MP3 may take several minutes to complete.  If you are in a 
hurry, you may want to just finish the session and use the Batch Email (next section) at a later time.
Click on the MP3 button, then in this window, use the Create File button to create the MP3.  When finished, 
click the Exit button or The red [x] in the upper right corner of this window to return to the Close Session Notes 
window.  

Email - Click the Email button on the Close Session Notes window to open the email dialogue below.  In this 
window, you should not modify the Provider Setup once established, unless your email address or password 
has changed.  These settings will usually be set during initial installation of the program by NMT Treeview 
support staff.  The tabs on the left of this window contain email templates that are included if there is an MP3 
or GEF attachment.  These can be modified, and will be outlined later in the Settings section of this manual.

If you have already made 
MP3/GEF files, they will be 
listed in the File Attachments 
window.  You can remove 
files by selecting and using 
the [-] Delete Selected File 
button.  Add files with the 
[+] Add File button.

You may add or edit the 
client’s email here.

Click the  Send button to 
send mail.  Progress will 
register in the bar at the 
bottom of window.  Click the 
blue arrow to return to Close 
Session Notes window.
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9.1) Batch Email of  MP3 and GEF Files
Batch Email - As the program closes, you have the option to send Batch Email, if Yes is selected, this window 
will come up.  You may also use the top menu bar option Tools > Batch Session GEF, MP3, Email... in System 
Maintenance mode.

The tabs on the top of this window contain other settings which can be modified, and will be outlined later in 
the Settings section of this manual.  This is intended to point out the items you need to run the Batch Emailer.

a) Display Window - Shows all sessions in date range.  You can individually select to include MP3 and GEF files 
for each client with the check boxes in the MP3/GEF columns.

b) Client Selection  - Choose to show All Clients, or limit display to a single client.  Use dropdown list for 
selection.  
	
c) Date Range  - Set date range to display.  Click on the calendar icon next to each date to set the From and To 
dates to include.

d) Progress Meters  - Shows progress for current GEF/MP3 creation, emailing of current files, and estimated 
overall progress for all emails.

e) Default Options  - Global options for all emails.  These will be discussed in detail later in the Settings section.

f) Use MSFT Outlook  - Checked sends emails using Microsoft Outlook.  You must have Outlook installed on 
your computer and set up to send mail.  This can be nice if you have Outlook set up to save copies of sent 
emails, as you have a record of the client’s emails sent, and they can be easily re-sent if the client has a 
problem receiving.

g) Start  - Click to start the Batch Email process, creating MP3, GEF, and sending email for each client in the list 
until completed.

a

b

c

d
e
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9.2) Closing Program and Auto Backup
When you click the Finish Session button, you 
are given the option of continuing with the 
program.  If you select Yes, you will be brought 
back to the Client Selection window, and you 
can begin a new session.  If you select No, 
you are given the option to Auto-Backup as 
the program closes.  The Auto-Backup feature 
creates a compressed version of your database 
that can be restored if there is a problem.

You should allow the program to auto backup 
after periods of significant use.  For some 
users, this may be daily. **

Select Yes to the Auto-Backup option to allow the program to create a backup file.  This procedure will 
periodically backup and restore your current database in order to economize data file space.  This may take a 
minute or so depending on the size of your database.

Backup files are saved in the location - C:\ProgramData\NMT Treeview\Professional\Data\DataBackup

** This Auto-Backup feature of Treeview is NOT a substitute for regular computer backups that should be 
done in case of a severe failure.  We suggest that you use a program like Acronis True Image to make regular 
full backups of your computer’s hard drive.  If you do not use a solution like this, you should make sure that 
you have regular scheduled or manual backups that include at least the Treeview program’s Data folder.  
With your program database, we can restore all of your client session data in the case of a severe hardware 
or software failure.



10) Registry and Program Toolbars
Client Registry Menu Detail

You’ll notice the new menu bar to the left of the Client Registry.  This menu bar splits up various Client 
Registry tasks to make them easier to find.  Hovering over each item on the bar will pop up a description 
of that tool’s functions.  Clicking on the icon will bring up the a list of functions which are available for the 
particular selected item(s) in the registry, or perform the given function.  Menu items with keyboard command 
equivalents will have those keyboard shortcuts displayed next to the menu item.

1) Common Functions - Typical tasks performed on a selection in the registry

a

b

c

d

e

f

g

h

i

j

k

l

m

n

1a) Move Checked Contents of Class to...  
Moves check marked items in selected registry 
folder to the selected destination, either a 
session only bin, or to the clipboard for pasting 
into a pathway table.

1b) Move All Checked Items to...  Moves check 
marked items in all registry folders to the 
selected session only bin.

1c) Move Selected Nodes to...  Moves selected 
items the selected session only bin.**

** note the distinction between checked and selected 
items/nodes in the menu items.  Checked refers to items 
that have check marks next to them.  Selected is when 
the item is clicked with the mouse, and changes color to 
indicate it is selected.  Multiple items may be selected 
by holding down the Ctrl key when selecting items, or a 
group of items using the Shift key.

1d) Delete/Hide Selected Node(s) - deletes selected item(s) 
from client registry.  Deleted items are hidden from view and 
may be recovered.

1e) Add Node - Adds a single item as a child or sibling of the 
currently selected registry item/folder.

1f) Add Multi-Nodes - Opens an editor panel that allows user 
to add multiple items at once or copy and paste material from 
another program.

1g) Change Node Status - Change a node from Item to Folder 
icon, Toggle Checked State, or Toggle Hide/Show item (for 
revealing a previously hidden item)

1h) Sort Tree Branch - Sorts selected registry folder 
alphabetically.

1i) Search Registry Tree Items - Search of items located in the 
Client Registry.

1j) Toggle Show Date Added - Displays date 
added to left of registry items.

1k) Show All Hidden Top Folders - Reveal older 
hidden/deleted folders in main registry (such as 
currently unused Session-Only bins or previous 
level All Session folders).

1l) Show All Hidden Child Nodes/Folders - 
Reveal older hidden/deleted sub-folders and 
items in registry (such as currently unused or 
previously deleted items).

1m) Check all children/grandchildren of 
Selected node - Adds check mark next 
to everything in selected folder (For 
Condition Specific Templates, this will check 
corresponding TTS folder when selected for TFS 
folder).
1n) UnCheck all children/grandchildren of 
Selected node - Removes check mark next to 
everything in selected folder.
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2) Move Functions - Duplicates functions 1a-c in the previous Common Functions menu.

4) Set Client Registry Auto-expand Width - Sets width of registry window.  Registry will snap to set width 
when a registry item is selected.

3) Copy/Paste Functions - Operations for copying items between registry and pathway tables.

a

b

c

d

3a) Copy Selected Nodes to CV Table Clipboard 
Ctrl+C - Selected nodes are copied to a memory 
location for pasting into a CV (pathway) table.

3b) Paste CV Table Rows as Children to 
Selected Node Ctrl+V - Paste table rows or 
other copied text items as sub items.

3c) Copy Checked Nodes to CV Table Clipboard Ctrl+Z - Copies all check marked nodes in selected folder.  In 
special cases, this function will copy two corresponding folders, such as TFS and TTS statement folders and Positive 
and Negative EDP or TSKNP statements.  Special use Client Registry copy functions is further detailed in a feature 
overview.
3d) Copy Checked Nodes to CV Table Clipboard - Copies all check marked nodes in selected folder.  In special cases, 
this function will copy two corresponding folders, such as TFS and TTS statement folders and Positive and Negative 
EDP or TSKNP statements.  Special use Client Registry copy functions is further detailed in a feature overview.

5) Show Pathway Tally - Opens dialog to display frequency of pathway use with current client for all 
previously recorded sessions within selected time period. Click Show History button to view history of use 
for selected pathway. Click NMT Path Tally Grid tab to return to pathway history list.
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6) Assessment of Registry Items - Allows user to look at assessment of TSB or other value over period of 
time for an item in the Client Registry.

a

b

c

6a) Toggle Registry Items Assessments ON/OFF (Alt+A) - Displays/hides assessment value to left of registry items.

6b) Show Vernier for Assessment - Pops up scale for recording evaluation in current session.

6c) Show Assessment Chart - Shows chart in bar or line form of assessment value over time.

This example shows 
evaluation of registry item 
Percent ACS Application of 
Protocol in Metrics folder.  The 
value changes from 50 to 70 
between sessions 21 and 23.  
The buttons in the lower left 
corner of this window switch 
between bar and line graph 
views.

7) Show Client Image - Picture of client may be added here.  Right click for menu to add or remove picture.

A typical scale used within Treeview is this 
1-1000 scale.  This may be used to record 
TSB in Log1000, or as shown here to record a 
percentage.  In any of these pop up scales, you 
can type in a value outside of the scale limits.
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8) Clear Nodes - For clearing items from a session only bin, or removing check marks from registry items.

a

b

c

8a) Clear this Session-Only Bin of all items - 
Removes all items from selected session only 
bin, for example, clearing the contents of Subject 
Matter : Current Session.

8b) Clear All Checked Nodes - Removes check mark from all items in entire registry.

8c) Clear All Checked Nodes of Class - Removes check mark from all items in selected folder only.

10) Toggle Resolved - For indicating resolution of an item. / Collapse all Registry Nodes - Collapses all open 
registry folders. Show Laboratory Reports/Images - must be in the Laboratory Reports folder for this to 
show.

11) Reset Client Registry Panels - Resets vertical height of Client Registry panels so that lower pane can be 
revealed to edit item (useful for changing item status).

12) Help - Pops up documentation panel for description of a number of Treeview menu items.

13) Client Recommendations Dialog - Here you may keep a list of additional recommendations for the client.

Double click on a 
category to add 
recommendations 
(one per line), and 
click OK.  You then 
have a variety of 
options to define the 
duration, priority, 
client compliance, 
comments, etc.
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Treeview Program Toolbars
This menu bar splits up various program tasks to make them easier to access.  The main program toolbar is 
divided by a slider you can adjust for optimal display.   

The left side always displays the tools 
shown, while the right side is split into 
two tabs (far right), which you can 
toggle to show different tools. 1 2 3 4 5 6 7

1) Back Up in Tree to last Jump To Node - More common in 
older pathways.  If you use a pathway Jump node to perform 
another pathway, this icon will return you to the original 
pathway.

This example shows a Jump To node 
in the Level 2 Hormone Pathway.  If 
you chose to perform the TP here, 
you would use the Back Up tool 
to return to the HP after you were 
finished with the TP.

2) New/Close Session - If in a session, use this button to bring up Closing Session dialogue.  If you are 
working in System Maintenance mode, use this button to bring up the Start Session Dialogue.

3) Filters On/Clear - This button may be used to turn Filters on or off.  You may browse the Filters 
tab in the Client Registry to choose various filters.  When the Filters On button is selected, you can 
then check mark indicated filters in the Filters tab.  This will prefix all signal output statements with a 
reference to the selected filters.

4) Register - For registering awareness of a particular item or 
group of items.  You may select a group of items in the Client 
Registry or pathways, or choose a particular session only bin.

Group of indicated items is 
read to signal output as shown.  
Here, 2 items were selected in 
the Client Registry.
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5) Drag & Drop - Allows user to move items in the registry or pathway trees.  With this button ON, 
you may use arrow keys to move an item up or down a list, or you can drag and drop the item onto 
another item to create parent/child relationship.  Be CAREFUL with Drag & Drop on, as you can make 
unintended moves, and lose order of your material.  After moving anything toggle Drag & Drop OFF.

6) Directional toggles - Changes foot pedal directions.  Early versions of NMT Treeview included a 
programmed foot pedal.  These are no longer being included in the program package, but a variety 
of external interface devices may be used.  Consult your particular device’s documentation for 
programming specific commands.

7) Signal Output - Toggles signal output ON/OFF.  When in ON position, button shows as yellow 
circle, selected statements are output to scalar antenna, and progress is shown in pop-up read along 
window. When OFF, only Wizard scans are output.

Here we have created a new 
registry folder called Old Subject 
Matter, and we can select some old 
Key Symptom items and then drag 
& drop them as children to the new 
folder.
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1) Search in Tree - Brings up search pane that allows user to search for a particular item within the 
program.  There are a variety of options to help narrow or expand the returned results.

2) Back Up buttons - Back up to previous CV Tree (Pathway level tab), or previous branch level of 
testing.  

Previous CV Tree - returns user to most recently used Pathway level tab.  If only one level tab has 
been used in a session, this icon will be inactive (greyed out).

Previous branch level of testing - returns to top of current level of testing within a pathway.  

Previous Branch Level: In this 
example within the AAIP,  the 
user would be returned to 
statement 2b.

Treeview Tab

1 2 3 4 5 6 7

Search Options - You can search 
for items based on matches 
within an item name or 
description.  With Incremental 
Search selected, matches will 
appear and narrow as you type 
the search term.  To go to a 
returned item, select the item in 
the matching item list, and then 
click the Show In Tree button.
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4) Session Notes - Opens notes begun at the start of the current session.  You may want to add to or 
edit notes as you proceed through the session.  These notes are client and session specific.

5) Workpad - This is a special Treeview editor that you can use to store text items for use between 
different clients and sessions.  Here you may want to store templated statements, commonly used 
subject matter considerations, etc.

6) Often Used Filters - If using filters, this tool will accumulate a list of most commonly used filters.

7) Reset - This button will reset the signal output.  If you are in a pathway, and the signal output read-
along window appears and hangs up, or does not appear at all, then the signal output may be stuck.  
Use this button to reset the signal output, then click on the next statement you want to output.

3) History - Opens panel that shows previous session history for the current client.  This will show the 
subject matter and pathways used in the lower panel. 
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NMT Tab

1 2 3 4 5

1) Block Scan - Reads the selected item(s) to scalar output.  For outputting and testing indication of a 
group of items in the Client Registry or pathway trees.

Use - Select a group of items in the registry or within the pathway Custom View trees, then click 
the Block Scan icon.  This will output the items as shown.  Might be used to register or test simple 
indication by MRT of the selected group of items.

This is not typically used in Treeview when working with NMT, but was an early addition in 
development, and still active in the program, so it is outlined here.  The Affinity Scan and Test shown 
next are also not associated with NMT, but they are available for your use and experimentation.
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2) Affinity Scan - Reads the selected item(s) to scalar output.  For testing possible indication of a 
group of items in the Client Registry or pathway trees.  Treeview uses an algorithm that determines a 
percentage of deviation from random in an large array of random number generation (RNG) events.

Use - Select a group of items in the registry or within the pathway Custom View trees, then click the Affinity 
Scan icon.  This will output the items as shown, and then display the result of the RNG tests to the left of each 
item.  Positive deviation shows as a GREEN bar, and negative deviation shows as RED. Might be used to test the 
percentage of indication of the selected group of items.* 

* NMT Seminars makes no claim of efficacy of this affinity scan.  However, there is a theoretical and experimental 
basis showing effect of conscious interaction on the statistical outcome of a series of RNG events.

Using the affinity 
scan will rearrange 
the tested items in 
the registry based 
on the test results.  
To restore the order 
of registry items, 
use the menu item 
shown, View > Reload 
Selected Tree... > 
Reload Client Registry 
Tree.
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3) Affinity Test - Reads the selected item(s) to scalar output.  For testing possible indication of a 
group of items in the Custom View pathway trees only.  Treeview uses an algorithm that determines 
a percentage of deviation from random in an large array of random number generation (RNG) events. 
Affinity Test results are displayed as affirmative/negative based on a set threshold value.

Use - Click the Affinity Test icon to turn this function on, and then select a group of items within the pathway 
Custom View trees and select Start Test of Selected Node(s) from the icon menu.  This will place a (?) icon next 
to items as shown, and then test each item in the selected group.  Positive deviation shows as a check mark, 
and negative deviation shows as ban symbol (/). Might be used to test possible indication within a selected 
group of items.* 

* NMT Seminars makes no claim of efficacy of this affinity scan.  However, there is a theoretical and experimental 
basis showing effect of conscious interaction on the statistical outcome of a series of RNG events.

Test Thresholds may be set to modify percentage 
of deviation to return a positive or negative 
result.  
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4) Pulse Signal - When turned ON, scalar output of the selected item is repeated until next item is 
selected.  Intended use of this tool was for NMT Rapid Pathways, where the pathway statement’s 
intention is held through dynamic MRT.

5) NMT Scalar Equivalent Tools - These are a collection of 
statements that reproduce scalar output for common queries 
that may be used within the NMT protocol.a

b

c d e

a) Display Affirmative/Negative/Neutral - For testing general MRT display.

b) Is?/Is NOT? - For testing individual MRT responses.  The Is? Is Not? button toggles to prefix the selected 
item.  Try selecting an item in the registry or within a pathway and then clicking this button to hear the output.

c) OK to Proceed? - Outputs the statement “Is it OK to proceed?“

f g i

d) USCS - Outputs full NMT Universal Scanning and Correction Statement.

e) Push - Initiates the full NMT Push routine. 

f) TSB Scan - Outputs the query, “What is the total system burden in regard to the referenced topic?“, and then 
pops up scale for recording log1000 TSB value.

h

g & h) Refreshing Protocol Definitions:

Outputs the simple reference statement, “Refresh Protocol Definitions?“

Outputs MRT language preferences and the full scanning and correction statements (shown below).

i) More? - Outputs the query, “More from this category?“, for possible use in MRT of pathway groups, or lists 
of items.
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11) More Customization and Settings Options

71

Email settings may be modified both in the Closing Session emailer, and the batch emailer.  We will look at 
both here.  For emailing files, see section 9 (pg 55-56).

Closing Session Email: From Closing Session Notes window, click the Email button to bring up the Closing 
Session emailer.

a

b

c

d

e f

g

a) Provider Setup: Treeview support staff will typically help you set this up during initial installation.  If your 
email provider, address, or password have changed, these settings will need to be modified.  Check with your 
provider for correct SMTP settings.  If you have Microsoft Outlook installed on your computer, and set up to 
send mail, you may check the Use MSFT Outlook box to send emails through the Outlook program.

b) Client Email: You may enter or modify the client’s email address.

c) File Attachments: Shows any MP3 or GEF files created during this session.

d) Add/Delete Selected File: Shows any MP3 or GEF files created during this session.  Click [+] to bring up file 
browser and choose file attachment to include.  To delete a file, select it in the File Attachments window, and 
click [-] to remove it from current email.

e) Email: Sends email with files listed in File Attachments window.  Email progress is shown in bar below.

f) Return: Click this button to return to the Closing Session Notes window.

g) Email Templates: These tabs contain general email templates that can be modified to personalize the 
message to your clients.  We’ll take a detailed look at modifying these templates on the next page.

11.1) Email Settings
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Email Templates: Email templates can be modified in the tabs on the left of this window.

Intro/General Email Template: This 
template contains an email introduction 
paragraph.  Notice the <Patient Name> 
and <Clinic Name> tags.  These are 
used to output the current client name 
and your clinic name from the program 
database.  Place these where you want 
in the modified text.

Check the Save Template box to save 
changes.

MP3 File Email Template: This template 
contains a section that is included in 
the email if an MP3 file is attached.  
Notice the <MP3_DURATION>, <MP3_
FREQUENCY> and <MP3_TIMEUNIT> 
tags in the second paragraph.  These 
are used to output the MP3 playing 
parameters.  Place these where you 
want in the modified text.  If you do not 
want parameters included in the email, 
you may delete this paragraph

Check the Save Template box to save 
changes.

The Include check box includes this 
paragraph, whether MP3 is attached or 
not.

PDF Reports Email Template: This template 
contains a section that is included in the email 
if a GEF file is attached.

Check the Save Template box to save changes.

The Include check box includes this paragraph, 
whether PDF is attached or not.



73

Batch Email: You have an option to open the Batch Emailer as the program closes.  You may open the Batch 
Email dialogue within the program by using the top menu bar option Tools > Batch Session GEF, MP3, Email... 
This section covers settings not shown in previous chapter on emailing files.  For instructions on emailing files, 
see section 9 (pg 55-56). 

a

b

c

a) Settings Tabs: Email List tab shows sessions for selected date range.  Additional tabs for email body, provider 
settings, and report sections (shown on next page).

b) Email Body Defaults: Choose to use email body written in second tab either instead of email templates 
(previous page), or as an appendix to the included templates.

c) Defaults: Global settings for sending emails in the batch.

Auto Send all Unsent Emails: All emails in the currently displayed list are included in the batch 
processing.  MP3 and GEF are produced, then email sent for each unsent email in the list.

Include GEF Reports in Emails: All emails are sent with GEF file attachment (in Adobe PDF format).

Include MP3 Files in Emails: All emails are sent with MP3 file attachment.

Include All Tables in GEF: GEF reports will include all tables used in session.  To select individual tables 
for a session, you can click on the button in the Select Tables column for that session.

Include Only Transform From/To Tables in GEF: GEF reports will include only TFS/TTS tables from 
completed pathways in session.
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Only Completed Session: Shows only sessions closed as completed in the list.

Todays Date Range: Displays the session completed for the current day by default.  You can modify the 
date range using the calendar icons next to the Date From and Date To fields in the lower left portion of 
this settings window.
Send Batch Emails: If checked, emails will be sent out as each session MP3 and GEF are produced.  If 
unchecked, MP3 and GEF files will be made for the listed sessions, but emails are not sent out.  You 
may want it unchecked if you want to distribute the files later, or will not be sending them directly to 
the client.  If you notice that your batch email is not sending, check to see if you have accidentally 
unchecked this box.
MP3 File Includes Playing Info: MP3 filenames are appended with playing frequency, duration, and 
time period for playing files, if set in MP3 playing parameters are set in the Wizard at the conclusion of 
a session.

Email Body Tab: Here you may write your own email body to use for batch emails.  The Use Email Body 
selection at the bottom of the email body window lets you choose to use this instead of email templates, or as 
an appendix to the included templates.  Templates may be edited in the Close Session Email dialogue shown in 
the previous settings section.

Email Settings Tab: SMTP settings for your email server.  This information can be obtained from your email 
provider.

Report Sections Tab: Report sections may be included or left out of GEF.  Users will not typically make changes 
to the included sections.  
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You may find you want to adjust the display size of some of the text within Treeview.  We will look at setting up 
font sizes for different areas of the program.

NMT Wizard: To adjust the display size of text in the NMT Wizard, use the up and down arrows on the Wizard 
Toolbar.  The reset button resets Wizard fonts to default size.

Pathway Tables: To adjust the display size of text in tables, use the up and down arrows on the Table Toolbar. 

11.2) Font Settings

Client Registry: Use the menu item Edit > General Settings > Client Registry/Filter Tree Font Setup to bring up 
the font settings window for the registry and filter trees.

Tabs in this settings window 
switch between the Client 
Registry and Filter Tree Font 
Setup panels.

Use the dropdown fields to 
select font face and size.  Click 
OK to set.

May take a minute or so for 
font sizes to change throughout 
registry.



Pathway Description Window: Use the right click menu item Font Settings > Default Setting in the display 
window to bring up the font settings window for View Image/Description Window.  Make adjustments, and 
then click OK to set.

Scalar Output “Read Along” Window: Use the menu item Edit > General Settings > Scalar Output Form 
Settings to bring up the font settings window for the scalar output window.

Use the dropdown fields to 
select font face and size.  Click 
Close Scan Display to close 
window and set font.
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Pathway Trees: Use the menu item View > Tree Option Settings to bring up the font settings window for the 
Custom View (NMT pathway) trees.

Click on the Default Custom View Tree Folder Font Metrics tab to change the size of the font throughout all of 
the pathway trees.  Individual tree fonts can be set in the list at the bottom of this window.  However, you will 
likely want to just use the global setting.
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12) Troubleshooting Tips

1) Password Fails:  Password entry returns authorization error.

12.1) Program Startup

2) Not Connecting to Database:  After entering password, as program opens, you may get a  database 
connection error.

Solutions:  Make sure you are entering your password correctly and that your Caps Lock key is OFF.  The 
password is case sensitive.

If you are sure you have entered your password correctly, contact Treeview Support.  We have observed a few 
instances where the password has become corrupted in Windows and must be manually reset.

If you have just started up your computer, it may be that all startup processes have not yet finished loading.  
The program requires Firebird database server program that is installed as part of the Treeview Program 
package.  If this has not yet loaded up, the program cannot start.

 Solutions:  Wait a few minutes for your computer to fully start up, and then start the Treeview program.  If 
your computer has been running awhile, try restarting the computer.  The database server will be reloaded 
on startup.  If neither of these work, call Treeview support.  Your program may need to be reinstalled, or your 
database may have been damaged.
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3) Treeview Hangs on Startup Connection/Security Check:  After entering password, as program opens, 
you may see the program hang at this point, right before the program window opens.

As the program starts up, it will check your computer for an internet connection.  If a connection is present, 
the program will attempt to connect to the Treeview server online to check for program updates and/or access 
changes.  If you have a weak, intermittent, or proxy internet connection, this connection may fail causing the 
program to hang during this opening splash screen.

 Solution:  Close the program, disconnect your computer from the internet, and start up the program again.  
Treeview will not see a network connection, and will skip the opening server connection.  This should allow the 
program to open quickly.  Your Treeview program requires periodic connection to the internet.  So this is only 
a temporary solution should you need to open the program to use right away.   Should the problem persist, it 
needs to be addressed with Treeview Support.

If you click your mouse a few times on the non-responding window, it should “grey out”, as pictured above, 
then Windows will pop up an option screen.  Choose Close the program, and Cancel on the next screen that 
pops up.  Then click the Wireless Network icon in the lower right corner of your desktop and disconnect from 
the network.  If you are on a wired connection, manually disconnect the network cable.  You may need to end 
the program with the Windows Task Manager, which will be shown at the end of this section.
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Treeview Program Error Messages:  There are a variety of instances where you might experience a program 
error.   Though an error message during an NMT session can be disconcerting, they do not necessarily indicate 
a problem with the session itself.  Emphasis here will be on what to do when you see an error message, 
continuing with the session, and/or restoring the session where possible if the program fails.

12.2) Program Error Mesages

The Generic Pop-Up Error Message:  Hopefully, the error you see does not mean the end of your session.  If it 
is possible for the program to continue, you should see the continue application option available on the pop-
up message.  Try clicking this button and continuing normally with the session, making a mental note of what 
may have caused the error, in case you should see it again.  

The program will attempt to send details of the error to Treeview Support so that we can analyze the error.  
The program will send the error report via your default Windows email program.  Your email program may 
require permission to send this mail, and you might see another pop-up window asking permission to use your 
email program.  If you do not have an email program like Outlook installed and set up to send email on your 
computer, the error report will be saved in your program folder so that TV Support may examine it later.  If you 
select to continue or close program and it seems to still not be responding, see if the email permission window 
is hidden by hovering over the Treeview icon on your Windows Taskbar as shown here.

Clicking show bug report will show the details of 
the error.  These will not typically be meaningful 
to users.  The full emailed report and your 
description of where and how the error occured 
are useful to TV Support in determining if there is 
a problem with the program.
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More Drastic Measures:  Sometimes it may not be possible to continue with a session.  If you are experiencing 
repeated pop-up errors from the program, or the program and/or computer are not responding normally, 
you may want to try closing the program, and sometimes restarting your computer.  If you are in the middle 
of a session, this can be problematic.  But in many cases, you can close the session as incomplete and restore 
the session after you have resolved the problem.  In case you are not able to manually close the session, the 
program may have enough saved information to restore the session after the program is restarted.  We’ll look 
at both possibilities.

12.3) Session and Program Restore

Session Restore:  If you’re having problems with the program, but it is not completely locked up, and you are 
still able to use program toolbars, try closing the session as incomplete so that you can resume it after you 
have addressed whatever problem you’re experiencing.

Use the Close Session button on the program toolbar in the upper left corner of the program to bring up the 
Close Session Notes Window.  In the Set Session Status dropdown, select Incomplete, then click the Finish 
Session button to close the program.  

Now you can reboot your computer if needed, and restart the program.
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When you restart the program and begin a session with the client, you’ll receive a notice of the pending 
incomplete session.  Select Yes to resume the incomplete session.  

Next, the Session Notes window will display any session notes and pathways completed or in progress.  Select 
Start Session, and the program will restore the session at the point of progress you left off.
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Program Restore:  If the program or computer crashes or closes unexpectedly, often Treeview will have enough 
information saved to restore the session that was in progress at the time of the failure.  In that case, you’ll see 
the Session Restore button active as shown below.  Click this button, then OK on the next confirmation. 

Next, the Session Notes window will display any session notes and pathways completed or in progress.  Select 
Start Session, and the program will restore the session at the point of progress you left off.



12.4) Email Problems
If you have previously had your email set up correctly, and it is not sending now for some reason, you might 
check a few things.

1) Internet connection - If you have a poor or no internet connection this may cause the program email or 
batch emailer to fail.  If so, close the program, resolve the internet problem, then you can open the program in 
Maintenance Mode and run the Batch Emailer to send out any unsent emails.

2) Your email address and/or password has changed.  This will cause the program email to fail.  In this case, 
you need to change the information in the Email Settings tab of the Batch or Session Email window.

3) Your network location - Some networks block certain internet ports associated with email.  If your email 
settings specify a default port like 25 for sending mail, that port is often blocked in hotels or other public 
networks.  Your email provider should have an alternate SMTP port to use in this case.  You can change the 
port number in the Email Settings tab of the Batch or Session Email window.
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12.5) Closing Program With Windows Task Manager
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If program controls are unresponsive, and you cannot close the program, you can end the program with 
Windows Task Manager.  Right click above the Windows Task Bar at the bottom of the screen and select Start 
Task Manager from the pop-up menu.

In the Applications tab of 
the Task Manager, select the 
Treeview Program from the list 
of running applications, and click 
the End Task button, or right-click 
and select End Task from drop 
down menu.

If Treeview is in the process of starting 
up or shutting down when the program 
freezes up, you may not see the 
program listed in the Applications tab.  
Check in the Processes tab of the Task 
Manager, select ProfViewer.exe from 
the list of running processes, and click 
the End Process button, or right-click 
and select End Process from drop down 
menu.
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